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ABSTRAK 

 

 Airside Inspection Vehicle adalah kendaraan yang dirancang oleh taruna – taruni Teknik 

Mekanikal Bandara Angkatan 6 dari motor tossa tiga roda menjadi kendaraan roda empat. 

Terdapat beberapa komponen yang masih digunakan. Komponen pada kendaraan ini belum 

pernah dilakukan pengujian sebelumnya. Velg merupakan komponen kendaraan yang 

penting. Pengujian kekuatan material velg terhadap beban statis dihitung menggunakan teori 

kesetimbangan yang kemudian dibandingkan dengan bantuan Software Ansys R17.0 

Workbench. Daerah yang diuji adalah Flange dan Hub Diameter. Diketahui berat kendaraan 

500 kg, sehingga tegangan pada flange dengan hitungan teoritis sebesar 0,382 MPa dan 

hitungan software 0,0002 MPa sedangkan pada daerah hub diameter tegangan dengan 

hitungan teoritis sebesar 10,74 MPa dan hitungan software 18,671 MPa dengan tegangan ijin 

sebesar 110 MPa. Hasil penelitian ini menunjukkan bahwa tegangan yang terjadi pada velg 

dianggap aman. 

 

Kata kunci: Airside Inspection Vehicle, Flange, Hub Hole Diameter 

 

ABSTRACT 

 

 Airside Inspection Vehicle is a vehicle designed by cadets of Airport Mechanical 

Engineering 6 from the vehicle tossa three wheels become the four wheel. The component of 

vehicle has never been done tested. A strength testing of wheel material against static 

working load is calculated using static structural and force theory and then compared by 

using software R17.0 Ansys Workbench. The tested area are flange and hub diameter. The 

vehicle load of 500 kg, the stress that occurs at flange using theoretical is 0,382 MPa and 

count software is 0,0002 MPa while stress that happen at hub diameter area is 10,74 MPa 

and count software is 18,671 with allowable stress of 110 MPa. The Result showed that the 

stress occurs at the velg considered safe.  

 

Keyword: Airside Inspection Vehicle, Flange, Hub Hole Diameter
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PENDAHULUAN 

 Airside inspection vehicle adalah 

sebuah sarana mobilitas kegiatan inspeksi 

untuk menunjang operasional jasa 

kebandarudaraan. Kendaraan ini 

digunakan oleh uni – unit terkait dalam 

melaksanakan inspeksi terhadap kondisi di 

lapangan atau sekitar bandar udara. 

Kendaraan ini harus dirancang mampu 

menghadapai segala kondisi permukaan 

jalan di sekitar bandar udara. 

 Taruna – taruni program studi 

Diploma tiga Teknik Mekanikal Bandara 

angkatan enam pada semester tiga dan 

empat telah merancang sebuah airside 

inspection vehicle. Kendaraan ini 

merupakan hasil modifikasi dari kendaraan 

motor tossa tiga roda menjadi kendaraan 

inspeksi dengan empat roda. Pada awal 

perancangan, ada beberapa komponen 

kendaraan motor tossa yang masih 

digunakan pada airside inspection vehicle 

yaitu engine, poros, knalpot dan gardan. 

Untuk pemilihan komponen airside 

inspection vehicle lainnya diambil dari 

komponen kendaraan pada umumnya yang 

sesuai dengan perancangan. 

 Dalam merancang sebuah kendaraan, 

keselamatan dan keamanan merupakan 

aspek prioritas. Oleh karena itu perlu 

dilakukan pengujian untuk memastikan 

kelayakan kendaraan tersebut sehingga 

aspek keselamatan dan keamanan dapat 

terpenuhi. 

 Airside inspection vehicle yang 

dirancang merupakan kendaraan 

modifikasi dan belum pernah dilakukan 

pengujian terhadap komponen – 

komponennya dan salah satunya adalah 

velg. Velg merupakan komponen 

kendaraan yang mendapat beban cukup 

besar, yaitu dari berat kendaraan itu sendiri 

dan gaya impak dari permukaan jalan. 

Dikarenakan velg merupakan komponen 

kendaraan yang penting maka karateristik 

material yang digunakan harus mampu 

menahan beban – beban yang bekerja 

termasuk beban statis. 

 Untuk mendapatkan data tentang 

karateristik material yang digunakan pada 

velg, pada umumnya akan dilakukan 

pengujian secara mekanik. Namun saat ini 

ada website yang menyediakan data 

karateristik material – material yang sudah 

ada, jadi penulis hanya perlu melakukan 

pengujian komposisi kimia untuk 

mengetahui jenis material bahan velg 

tersebut kemudian mencari data di website. 

Data karateristikmaterial tersebut 

digunakan sebagai data pendukung dalam 

simulasi numeric pada perangkat Ansys. 

Untuk membuktikan bahwa velg tersebut 

dapat digunakan pada airside inspection 

vehicle maka penulis akan melakukan 

perhitungan dan analisa terhadap bagian – 

bagian velg. 

 Dikarenakan permasalahan di atas, 

maka penulis mengangkat tugas akhir 

berjudul “Analisis Struktur Velg pada 

Modifikasi Airside Inspection Vehicle 

Menggunakan Perangkat Lunak Ansys 

(Studi Kasus: Kendaraan Dioperasikan 

pada Jalan Inspeksi Bandar Udara 

Budiarto)” 

 

LANDASAN TEORI  

1. Velg 

Velg atau rim adalah lingkaran luar desain 

logam yang tepi bagian dalam dari ban 

sudah terpasang pada kendaraaan seperti 

mobil. Sebagai contoh pada roda sepeda di 
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tepi lingkaran yang besar menempel pada 

ujung luar dari jari – jari roda yang 

memegang ban dan tabung. 

Diameter (efektif) adalah jarak antara 

bekel (untuk ban), yang diukur pada 

bidang rimi dan melalui sumbu pusat yang 

sedang akan dipasang atau yang 

merupakan bagian integral dengan tepi. 

Lebar (efektif) adalah pemisahan jarak 

antara tepi flensa. Tipe tergantung pada 

jenis kendaraan dan ban. Ada berbagai rim 

(velg) seta jumlah komponen rim. 

2. Besi atau Iron (Fe) 

 Besi adalah logam yang paling banyak 

digunakan mencakup 92% dari produksi 

logam dunia. Biayanya yang rendah dan 

kekuatannya yang tinggi membuat sangat 

diperlukan dalam aplikasi teknik seperti 

pembangunan mesin dan peralatan mesin, 

mobil, lambung kapal – kapal besar dan 

komponen struktur bangunan. Karena besi 

murni cukup lunak hal ini paling sering 

dikombinasikan dengan unsure paduan 

untuk membuat baja. 

a. Sifat – sifat Besi 

 1) Sifat Fisik Besi 

  Sifat fisik dari besi dapat  dilihat 

pada tabel di bawah ini. 

Tabel 1 Sifat fisik besi 

  

  

 

 

 

 

2) Sifat Mekanik Besi 

  Adapun sifat – sifat  mekanik 

 dari besi adalah sebagai  berikut: 

a Kekuatan Tarik Maksimum 

Merupakan tegangan maksimum 

yang dapat ditanggung oleh 

material sebelum terjadi 

perpatahan. 

 

b Titik Luluh dan Kekuatan 

Lulus 

Merupakan suatu batas dimana 

material akan terus mengalami 

deformasi tanpa adanya 

penambahan beban, tegangan 

yang mengakibatkan bahan 

mengalami mekanisme lulus ini 

disebut tegangan luluh 

 

c Modulus Elastisitas 

Merupakan ukuran kekakuan 

material, semakin besar harga 

modulus maka semakin kecil 

regangan yang terjadi pada 

pembebanan tertentu. 

 

d Modulus Ketangguhan 

Merupakan sifat material dalam 

menyerap energy hingga terjadi 

perpatahan. 

3. Konsep Kesetimbangan 

 Suatu partikel dalam keadaan 

seimbang jika resultan semua gaya yang 

bekerja pada partikel tersebut nol. Jika 

pada suatu partikel diberi 2 gaya yang 

sama besar, mempunyai garis gaya yang 

sama dan arah berlawanan, maka resultan 

gaya tersebut adalah nol. Hal tersebut 

menunjukkan partikel dalam 

keseimbangan. 
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 Sebuah benda tegar dikatakan dalam 

keadaan seimbang jika gaya – gaya yang 

bereaksi pada bedna tersebut membentuk 

gaya/sistem gaya ekuivalen dengan nol. 

Sistem tidak mempunyai resultan gaya dan 

resultan kopel. Syarat perlu dan cukup 

untuk keseimbangan suatu benda tegar 

secara analitis adalah: 

(i) jumlah gaya arah x = 0 (∑Fx = 0) (ii) 

jumlah gaya arah y = 0 (∑Fy = 0) (iii) 

jumlah momen = 0 (∑M = 0) 

 Dari persamaan tersebut dapat 

dikatakan bahwa benda tidak bergerak 

dalam arah translasi atau arah rotasi 

(diam). Jika ditinjau dari Hukum III 

Newton, maka keseimbangan terjadi jika 

gaya aksi mendapat reaksi yang besarnya 

sama dengan gaya aksi tetapi arahnya 

saling berlawanan. 

a. Tumpuan 

 Tumpuan dibagi menjadi tiga jenis 

tumpuan yang biasa digunakan dalam 

suatu konstruksi yaitu tumpuan roll, 

tumpuan sendi dan tumpuan jepit. 

b. Beban 

 Beban atau muatan merupakan aksi 

atau gaya atau beban yang mengenai 

struktur. Beban dapat dibedakan menjadi 

beberapa jenis berdasarkan cara kerja dari 

beban tersebut.  

1) Beban Terpusat, beban yang 

mengenai struktur hanya pada 

satu titik tertentu secara terpusat. 

2) Beban Terdistribusi Merata, 

beban yang mengenai struktur 

tidak terpusat tetapi terdistribusi 

baik terdistribusi merata ataupun 

tidak merata. 

3) Beban Momen, beban dapat 

berupa adanya beban titik pada 

konstruksi menimbulkan momen 

atau momen yang memang 

diterima oleh konstruksi seperti 

momen puntir (torsi) pada poros 

dan transmisi. 

4. Tegangan 

 Tegangan dapat didefinisikan sebagai 

tahan dalam yang disediakan oleh satuan 

luas bahan kepada beban luar yang 

diberikan. Adapun macam – macam 

tegangan yaitu tegangan normal dan 

tegangan geser. 

5. Ansys 

 Ansys merupakan perangkat lunak 

komputer umum yang mampu 

menyelesaikan persoalan – persoalan 

elemen hingga dari permodelan hingga 

analisis. Ansys dapat mengimpor data 

CAD tetapi juga membuat geometri 

dengan kemampuan “preprocessing”. Ini 

digunakan untuk mendefinisikan beban 

dan melakukan analisis, hasil dapat dilihat 

sebagai numeric dan grafis.  

6. Cara Kerja Ansys 

 Ansys bekerja dengan sistem metode 

elemen hingga dimana penyelesaian pada 

objek dilakukan dengan pendeskritisasian 

dengan membagi atau memecah objek satu 

kesatuan ke dalam jumlah terbatas elemen 

hingga yaitu menjadi bagian – bagian lebih 

kecil yang dihubungkan oleh node. Proses 

tersebut adalah meshing. Ada beberapa 

meshing yaitu: 

a Assembly Meshing 

Assembly meshing mengacu pada 

meshing seluruh model sebagai single 
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mesh process, sebagai pembanding 

untuk bagian atau body based meshing. 

Dimana meshing tejadi pada part atau 

bagian tubuh model masing-masing. 

 

b Meshing by Algorithm 

Pada bagian ini menjelaskan tipe 

meshing dalam ketentuan pada “patch 

conforming” dan “patch independent” 

meshing algoritma. Pada beberapa 

kasus algoritma bekerja pada bagian 

level dan lainnya, pada assembly level. 

 

c Meshing by Element 

Bagian ini mendeskripsikan tipe dari 

meshing dalam hal bentuk elemen. 

Pilihan pengaturan mesh yang berlaku 

untuk setiap bentuk elemen 

yangdipertunjukkan dan dioperasikan 

pada level bagian kecuali kalau ada 

catatan. 

 

8. Kriteria Von Mises 

 Von Mises menyatakan bahwa akan 

terjadi luluh bilaman invariant kedua 

deviator tegangan J2 melampaui harga 

kritis tertentu. Dengan kata lain luluh akan 

terjadi pada saat energy distorsi atau 

energi regangan geser dari material 

mencapai suatu nilai kritis tertentu. Secara 

sederhana dapat dikatakan bahwa energi 

distorsi adalah bagian dari energi regangan 

total per unit volume yang terlibat di 

dalam perubahan bentuk. 

 

METODOLOGI PEMODELAN 

 Untuk mendapatkan ukuran velg yang 

sesuai aslinya, maka terlebih dahulu 

dilakukan pengukuran terhadap bagian – 

bagian velg kemudian diproyeksikan 

kembali menggunakan bantuan software 

AutoCAD. Diameter velg yang digunakan 

sebesar 330,2 mm dan lebarnya sebesar 

127 mm. 

 Untuk menyelesaikan penelitian ini, 

maka dibuat kriteria sehingga didapatkan 

hasil yang diinginkan. Adapun kriteria 

diambil dari bagian velg yang termasuk 

daerah kritis yaitu flange dan hub diameter 

dimana bagian ini tidak boleh terdeformasi 

apabila terjadi tegangan pada velg. 

PENYAJIAN MODEL DAN 

IMPLEMENTASI  

 Dalam proses penelitian atau 

pemodelan ada beberapa tahapan yang 

penulis lakukan untuk mendapatkan hasil 

yang diinginkan, adapun tahapan – 

tahapan tersebut adalah: 

1. Beban Statis 

Untuk menghitung beban statis yang 

bekerja pada masing – masing roda 

atau velg dapat dihitung menggunakan 

konsep kesetimbangan dimana berat 

kendaraan 500 kg sehingga dengan 

rumus 

0)8,9(50022;0  FBFAFmomen
s

ehingga didapat bahwa beban yang 

bekerja pada masing – masing velg 

sebesar 1229,0099 N. 

 

2. Flange  

Dalam menghitung tegangan yang 

terjadi pada daerah ini perlu diketahui 

terlebih dahulu permukaan flange 

dengan menggunakan rumus,  

  3xdflangeA   

Sehingga didapat 3202,8 mm2, dengan 

demikian dapat dihitung tegangan yang 

terjadi sebagai berikut: 

A

F
  

Sehingga tegangan yang terjadi adalah 

0,3824 MPa. 
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3. Hub Hole Diameter 

Hub hole diameter merupakan lubang 

tengah velg yang berfungsi sebagai 

penopang velg ke mounting mobil. 

Tegangan yang terjadi pada daerah ini 

dipengaruhi oleh gaya yang bekerja di 

bolt hole dimana baut yang digunakan 

berukuran 12 mm, sehingga dapat 

dihitung tegangan yang terjadi sebesar  

MPammN

A

F

baut

baut

6345,3/6345,3

26,84

25,306

2 





 

Dimana dilakukan perhitungan terlebih 

dahulu pada luas permukaan dan 

tegangan pada masing – masing baut 

dikarenakan ada 4 baut yang 

digunakan dalam penyambungan velg. 

Untuk menghitung tegangan 

maksimum yang terjadi menggunakan 

perhitungan sebagai berikut: 

MPammN 74,10/74,10

419,115

21,102209,13

2

22,20
6345,3

2

2

2

2

2

2

max






























 

Uji Coba Teoritis Model 
Untuk melakukan pembuktian pada 

teori yang telah dilakukan maka penulis 

menggunakan software Ansys. Adapun 

langkah – langkahnya sebagai berikut: 

1. Tampilan Awal Ansys 17.0 

Workbench 

Software ini mampu melakukan 

analisa pembebanan aksial, analisa 

temperature, deformasi, defleksi, 

tegangan pada truss dan sebagainya.  

Gambar 1 Tampilan Awal Software 

Ansys 17.0 Workbench 

2. Definisi Sistem Analisa 

Untuk mendefinisikan sistem 

analisa, maka langkah - langkahnya 

sebagai berikut: pilih menu Toolbox > 

Static Structural. Dan selanjutnya pilih 

Engineering Data > masukan nama 

material Velg yaitu Low Alloy Steel 

pada kolom “Click here for a new 

material”.  

Gambar 2 Tampilan Engineering Data 

3. Mendefinisikan Material Properties 

Langkah selanjutnya adalah 

menentukan sifat properties material 

velg yang telah didapat. Langkah – 

langkah mendefinisikan material 

adalah sebagai berikut klik Physical 

Properties > Density, klik Linear 

Elastic > Isotropic Elasticity, klik 

Strength > Tensile Yield Strength & 

Ultimate Tensile Strength. Kemudian 

masukan nilai dari massa jenis, 

modulus elastisitas, passion ratio, 

Tensile Yield Strength dan Ultimate 

Tensile Strength.  
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Gambar 3 Tampilan Material 

Properties 

4. Tampilan Gambar Velg 

Untuk dapat melakukan simulasi, 

maka velg terlebih dahulu digambar 

dengan menggunakan Software 

AutoCAD. Kemudian file di export ke 

bentuk SAT. Langkah untuk 

mengimport gambar dari AutoCAD 

adalah pilih Geometry, File > Import 

External Geometry File > pilih gambar 

yang disimpan dalam bentuk SAT > 

Open > Generate.  

Gambar 4 Tampilan Gambar Velg 

5. Proses Meshing 

Langkah meshing adalah sebagai 

berikut pilih Model > Geometry Part 1 

> Material > Assignment > ganti > 

Structural Steel menjadi Low Alloy 

Steel. Lakukan refinement pada bagian 

velg yang berbentuk membulat unutk 

mendapatkan hasil proses meshing 

yang lebih teliti. (Tipe meshing yang 

digunakan adalah meshing patch 

independent) 

Gambar 5 Tampilan Hasil Proses 

Meshing 

 Pengujian dilakukan sebanyak 5 kali 

dengan merubah besaran element size 

pada proses meshing sebesar 5 mm, 10 

mm, 15 mm, 20 mm dan 25 mm. 

Proses ini dilakukan untuk melihat 

apakah besaran element size pada 

proses meshing berpengaruh pada hasil 

tegangan yang terjadi. 

6. Proses Static Structural 

Pada langkah ini yang 

dilakukan adalah klik kanan pada 

Static Structural > Insert > Fixed 

Support kemudian pilih permukaan 

tumpuan yaitu pada empat lubang baut 

> Apply.  

 

Gambar 6 Tampilan Velg Hasil Fixed  

Support 

Selanjutnya pilih kembali Static 

Structural > Insert > Force > Vertex 

(pembebanan titik) > pilih bagian 

Flange > Apply. Masukkan besar nilai 

beban dengan cari pilih Definition > 

Define by > ubah Vector menjadi 

Component > masukkan nilai beban 

pada komponen tersebut. 

Gambar 7 Tampilan Setelah 

Pembebanan 

Dari gambar di atas dapat dilihat 

bahwa velg mendapat pembebanan 



Jurnal Ilmiah Aviasi Langit Biru Vol. 9 No 3 Oktober 2016 Hal 1 : 66 
 

20 
 

sebesar 1225,0099 N dimana nilai 

beban tersebut di dapat dari 

perhitungan secara manual yang telah 

dilakukan.  

7. Proses Solution 

Pada proses ini kita akan 

menentukan besarnya tegangan yang 

terjadi. Langkahnya adalah klik kanan 

pada Solution > Insert > Stress > 

Equivalent Stress(von mises). Langkah 

ini dapat dilihat pada gambar 4.13. 

Pemilihan equivalent stress (von 

mises) dikarenakan tegangan ini dapat 

mewakili ataupun memprediksi tingkat 

keluluhan suatu material terhadap 

kondisi pembebanan yang terjadi pada 

hasil pengujian. 

Gambar 8 Tampilan Velg Hasil 

Solution 

Interprestasi Hasil Uji Coba 
Hasil analisa menggunakan Software 

Ansys didapat 5 hasil dikarenakan 

dilakukan pengujian pada besaran element 

size pada proses meshing.  

Hasil Equivalent (von-mises) stress 

dengan element size sebesar 5 mm 

 Gambar 9 Hasil Equivalent (von-

mises) stress dengan element size 5 mm 

Hasil Equivalent (von-mises) stress 

dengan element size sebesar 10 mm 

Gambar 10 Hasil Equivalent (von-mises) 

stress dengan element size 10 mm 

Hasil Equivalent (von-mises) stress 

dengan element size sebesar 15 mm 

Gambar 11 Hasil Equivalent (von-mises) 

stress  dengan element size 15 mm 

Hasil Equivalent (von-mises) stress 

dengan element size sebesar 20 mm 

 

Gambar 12 Hasil Equivalent (von-mises) 

stress dengan element size 20 mm 

Hasil Equivalent (von-mises) stress 

dengan element size sebesar 25 mm 
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 Gambar 13 Hasil Equivalent (von-

mises) stress dengan element size 25 mm 

Setelah dilakukan perhitungan 

menggunakan teoritis dan simulasi 

menggunakan software Ansys maka 

didapatkan hasil dalam tabel berikut: 

Tabel 2 Hasil Perbandingan Teoritis dan 

Software 

Pada hasil perbandingan dapat dilihat 

bahwa nilai dari tegangan yang dianalisa 

memiliki nilai teoritis yang lebih kecil 

daripada nilai pada pemodelan. Banyak 

faktor yang mendasari perbedaan nilai 

yang di dapat seperti tabel 2 di atas. 

Umumnya pada proses meshing dan 

toleransi dari perhitungan. Selain itu 

properties dari material juga 

mempengaruhi dari perhitungan pada 

pemodelan.  

 

KESIMPULAN 

 Dari penelitian yang telah dilakukan 

dapat disimpulkan sebagai berikut: 

 

1. Tegangan yang terjadi pada daerah 

flange dengan beban sebesar 

1225,0099 N dengan luas penampang 

flange sebesar 3202,8 mm2 dengan 

perhitungan secara teoritis adalah 

0,3824 MPa sedangkan tegangan yang 

terjadi menggunakan software sebesar 

0,0002 MPa. Sehingga dapat dikatakan 

bahwa flange  aman karena tegangan 

yang terjadi tidak melebihi tegangan 

yang diijinkan material velg yaitu 

sebesar 110 MPa. 

 

2. Tegangan geser yang terjadi pada 

daerah bolt hole dengan beban sebesar 

1225,0099 N dengan luas penampang 

84,26 mm2  menggunakan perhitungan 

secara teoritis adalah 3,6345 MPa dan 

tegangan geser maksimum sebesar 

10,74 MPa. Sedangkan perhitungan 

menggunakan software sebesar 3,1121 

Mpa dan tegangan geser maksimum 

sebesar 18,671 MPa. Sehingga daerah 

Hub diameter aman karena tidak 

melebihi tegangan yang diijinkan yaitu 

sebesar 110 MPa. 

 

DAFTAR PUSTAKA 

 

Irawan, Agustinus P. (2009). “Diktat 

Elemen Mesin” Jurusan Teknik 

Mesin Fakultas Teknik Universitas 

Tarumanegara. 

Irawan, Agustinus P. (2007). “Diktat 

Kuliah Mekanika Teknik (Statika 

Struktur)” Jurusan Teknik Mesin 

Fakultas Mesin Universitas 

Tarumanegara. 

Khurmi, R.S. J.K. Gupta. A Textbook of 

Machine Design. S.I. Units. 

Eurasia Publishing House (Pvt) 

Ltd. New Delhi. 2005. 

Khurmi, R.S. Strenght Of Materials. S. 

Chand & Company Ltd. New 

Delhi. 2001 



Jurnal Ilmiah Aviasi Langit Biru Vol. 9 No 3 Oktober 2016 Hal 1 : 66 
 

22 
 

Sularso. (2000) Dasar perencanaan dan 

pemilihan elemen mesin. Jakarta : 

PT. Pradnya Paramita 

Surdia, Tata & Saito, Shinroku. (1999). 

Pengetahuan Bahan Teknik. 

Jakarta : Pradnya Paramitha 

 

 


